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UPCOMING DI GROUP EVENTS
Details of all DIG events are available on the Group’s website at:
www.rps.org/special-interest-groups/digital-imaging/events

Some future events include:
DI Group Thames Valley
Sunday 19th October 2014
Woosehill Community Hall, Emmview Close,
Wokingham RG41 3DA
Final details to be confirmed – please check
website.
DI Group Annual Print Exhibition
01 October 2014 – 31 October 2014
Smethwick Photographic Society
Club Rooms, The Old School House,
Churchbridge, Oldbury B69 2AS
A wide cross-section of work from members
of this RPS Group. The Exhibition is this
year’s Selectors’ choice from all of the prints
submitted, with at least one print accepted
from every entrant. This Exhibition will travel
to various venues in the UK.
PLEASE NOTE that the dates for
this exhibition venue are currently
PROVISIONAL, and that opening hours are
yet TO BE CONFIRMED.
Contact: Marilyn Taylor ARPS
Email: digexhibitions@rps.org
Cost: Free
DI Group Southern Centre: David
Mallows- Adobe Photoshop Workshop
Sunday 16 November 2014
Greyfriars Community Centre,
44 Christchurch Road, Ringwood, BH24 1DW

This lecture workshop is aimed primarily
at intermediate to advanced users of
Photoshop and a working familiarity
with the menus and use of layers will be
anticipated. Topics covered will include as
time permits: Adobe Camera Raw adjustment tools
•
Advanced layers and layer masks
•
•
Retouching tools for portraits
Selections
•
•
Creating composites
•
Adjustments using frequency
separations.
David Mallows is a professional
photographer and re-toucher. He is an
Adobe Certified trainer. Many of the
examples used for demonstration will be
from his professional work.
Time: 10.30 – 1600
Contact: Dr Barry Senior Hon FRPS
Email: digsouthern@rps.org
Cost: DIG Members £6, RPS Members £10,
Non RPS Members £10
Booking Form: Download from website
Advanced Booking Strongly
Recommended
DI Group Thames Valley: Member
Presentations + Millennium Cup
Competition for Prints
Sunday 23 November 2014
Woosehill Community Hall, Emmview Close,
Wokingham RG41 3DA

A searchable, cumulative contents list of previous issues 41-59 is available
from the DIGIT Group Magazine page of the Group’s website at:

DIGITAL
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Millennium Cup Competition for Prints
“This year ... next year”: a summary by
your Centre Organiser
•
Open Forum – your turn to speak.
Time: 10:00 – 15:30
Contact: Laurie Pate
Email: digthamesvalley@rps.org
Cost: DIG Members £6, RPS Members £10,
Non RPS Members £10
•
•

DI Group Western – Gavin Hoey Live
Demonstration
Sunday 14 December 2014
Clyst St Mary Village Hall, Clyst St Mary,
Nr Exeter EX5 1BG

www.rps.org/special-interest-groups/digital-imaging/about/030-digit-group-magazine
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What better way to learn more about
the latest techniques in photography
and Photoshop than by watching a live
demonstration from Gavin Hoey? He aims to
educate, inspire and entertain. This is an all
day live demonstration special event which
is being held at Clyst St Mary Village Hall,
Near Exeter, EX5 1BG Lunch 13.00 – 14.00
and packed lunches are advisable although
there is public house and corner shop
nearby. Doors open at 10.00
Time: 10.30 – 1600
Contact: Janet Haines ARPS
Email: digwestern@rps.org
Cost: DIG Members £6, RPS Members £8,
Non RPS Members £10
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EDITORIAL

A

ccompanying this issue of DIGIT is
a Monograph dedicated to Eddy
Sethna FRPS who was one of the
pioneers or founding fathers of digital
imaging. Eddy gave great service to the
photographic community in lecturing and
judging and served for many years on the
Council of the Royal Photographic Society
and was Vice President for two years. In
2004 he was awarded the Fenton Medal and
Honorary membership for his outstanding
contribution to the RPS. He was also Vice
Chairman of the RPS Digital Imaging Group
for a number of years and the first Chairman
of the then Midlands RPS Digital Imaging
Group (MIDIG).

roles. Margaret Salisbury has written an
appreciation of his service and John himself
has provided some of his favourite images
for us to enjoy.

Here in DIGIT No 62: 2014 Issue 3 we are
paying tribute to John Long ARPS, recently
awarded an Honorary Life Membership
of DIG, who is one of our longest-serving
members. He has contributed many years of
service as a committee member in various

In our recent Projected Image Competition
we had far more entries in the Open section
than in the Creative section, confirming that
our interests are diverse. All of the successful
images that were accepted by our selectors
will be featured in DIGIT No 63: 2014 Issue 4

W

Admittedly some of us enjoy ‘playing’ on
the computer, perhaps trying to produce
creative images. Viveca Koh tells us the story
behind her recent successful FRPS panel, in
which she made use of texture layers and
multiple overlays to produce her creative
images.
In the ‘Back to Basics’ series, Clive Haynes
FRPS discusses some of the considerations
when making montages and there is also a
page with a few very basic tips that might
be useful.
I hope readers will agree that I am trying
to keep the content of DIGIT as varied as
possible. If there is a topic that I haven’t
covered that you would like to write about,
please send me an email.
Carole Lewis ARPS digiteditor@rps.org

FROM THE CHAIR

hat is your approach to your
photography? Are you the guy
who is technically adept both with
your software and camera equipment or do
you approach it totally from the viewpoint
of light and emotions?
There is no right or wrong – often our own
character leans us one way or another,
dictating what we like shooting and often
we stay in our comfort zone a little too
much. Trying something else challenges us
and we fear we might have some failures if
we don’t stick to the tried and tested, but
failure is good.
I suggest to you that we learn more from
failure than we ever do from winning the
medals, so long as we are big enough to
learn from the experience.
If you have an image you like and it isn’t
doing as well as you think it should, be
really critical of it. We are often our own
best judges, as only we know how we want
our art to look. But we need to try to be
truly objective about our work. Is it too flat,
4

I heard recently that there might be a
misconception that DIG is just about
montaged images. That is certainly not true
– we embrace all genres of photography
and welcome members of all abilities from
beginners to advanced. Some individual
members may specialise, for example in
landscapes, portraits or natural history, but
we all aim to improve our digital techniques
regardless of whether we produce ‘straight’
images or manipulated ones.

which will be published later this year.

have you introduced halos, could you crop
it to make it a stronger composition, would
it look better as a mono? The possibilities
are endless. But also take the views of
others whom you respect, whether that is
club colleagues, through online forums or
judges. All views are valid and from them
you learn if you listen well.
Next you need to consider trying to
make some changes to the work and
experimenting a little. ‘Experimenting’
might even mean that you need to learn a
new technique. There is so much out there
on the web that I doubt there is anything
you can think of that someone won’t have
made a tutorial for. So ‘Google’ it. Or it might
mean recognizing that you need to go and
shoot it again in a better light, or use a filter
or different camera settings. Perhaps you
need to give more direction to your models
to get the emotional input from them that
you desire. Often reshooting just isn’t a
possibility, in which case you are stuck with
your original file; but that doesn’t mean it
cannot be improved.

So give yourself some time with one of your
images that you like but which has room for
improvement. Fail through it: learn from it.
At the end of the day it is great to put the
‘before’ and ‘after’ side by side and see for
yourself what you can achieve, with just a
little bit of extra effort.
Finally, on a different subject, it was my
pleasure and delight to present the very first
Honorary DIG membership to John Long
ARPS on behalf of all members and the
committee at a meeting at the RPS, Fenton
House, Bath on 27 August 2014.
In the words of Jim Buckley who worked
alongside John as a previous DIGIT Editor
but was unable to attend: “To a great
man, a great and appropriate award. Well
done John. You have inspired so many
photographers over the years and done so
selflessly, quietly and professionally. This
award shows just how much the Digital
Imaging Group owes you and how highly
you are regarded by so many friends.”
Janet Haines ARPS digchair@rps.org
RPS DIGIT Magazine 2014 Issue 3
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HONOURING JOHN LONG ARPS
John Long was awarded the first Honorary Life Membership of DIG
recently to acknowledge the many years of service that he has given
to our Group. John was surprised and delighted at this honour and
since then has provided some of his favourite images to accompany
this article by Margaret Salisbury, who explains that his contribution
to the photographic world as a whole is even greater.
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Janet Haines ARPS presenting John Long ARPS with his Hon DIG certificate
Photo by Barry Senior FRPS

T

he Digital Imaging Group (DIG), in
honouring John Long with Honorary
Life Membership, is acknowledging
just one aspect of the contribution that John
has made to the Photographic World.
John joined the DIG in 1998 just one year
after the first meeting and, since then
has hosted many Committee Meetings
in his own home, has given support and
encouragement to all those involved, as
well as helping Members in so many ways
that it’s impossible to relate them all. His
RPS DIGIT Magazine 2014 Issue 3

significant contributions include working on
the DIG Exhibition, managing the publicity
and website information, and always being
there whenever he was needed or whenever
he could help the Group to become the
successful and enjoyable Group it is today.
I have known John for more than 30 years
and, as all who know him will testify, he is
one of the most generous, kind and caring
men you could ever meet. In asking those
who know John for information, many
tributes were made such as: “John is a
shining example of a good Volunteer; when he

is asked to do anything he always does it both
willingly and efficiently”, “John’s contributions
to Photography have been a lifetime of service
to the work of the RPS, the Groups and his own
Photographic Society helping Members to
progress and supporting all who seek his wise
counsel and practical advice. John is always
there to help beginners and encourages
everyone who needs help to achieve their
aim whether it be in Club competitions
Distinctions or other achievements”, and
“John is a constant source of inspiration to
newcomers to Digital Imaging, displaying
5

MARGARET SALISBURY FRPS

a tireless enthusiasm for hard work coupled
with infinite patience in helping others master
digital photography despite his own busy life”.

Autumn

John took up Photography in 1949 and
joined the Kingswood Photographic Society
in 1955 where he has been a loyal and
faithful member, including serving as Hon.
Secretary for 43 years and President for
10 years. Providing accommodation and
hospitality for Speakers visiting Kingswood
Photographic Society and other events has
become legendary, all without asking for
anything in return.
For 50 years John lectured and judged,
was an Evening Class Tutor, Demonstrator
of Studio Portraiture and Lighting, as well
as being an active photographer himself,
travelling and producing AV sequences, and
Assessing Distinctions. All this and more has
been, and much still is, part of John’s life.

Bottles in the Window

John is a talented and excellent
photographer who, after a number of years
doing Mono printing and Slides, started
Digital Photography in 1995. John was
producing Creative Composite Images and
winning awards as long ago as 1996 (see
‘Autumn’) and continues making Creative
images, which have won awards (see
‘Bottles in the Window’) as well as enjoying
Portraiture, Figure Study, Landscapes/
Seascapes, Travel and Wedding Photography
as well as AV Sequences.
John joined the Royal Photographic Society
(RPS) in 1979, was awarded an LRPS with
Prints in 1980, followed by an ARPS with
a Slide submission in 1990. His interest in
Distinctions resulted in his giving many
years and hundreds of hours service to
the RPS Distinctions working as a ‘Scribe’
for numerous Panels in many if not all
the Sections of Distinctions. Arguably, it
is believed that he has seen more panels
assessed than almost anyone else including
members of the Staff of the RPS.
John served on the Licentiateship panel as a
Member of the Panel for four years followed
by six years as Chairman. During this time he
not only offered help on Assessment days
for those unsuccessful entrants but also
continued to Mentor all those who asked
for or needed his help for many weeks or
months until they achieved the Distinction.

Girl and Swirls
6

In recognition of John’s service to the RPS,
in 2001 he was awarded the Fenton Medal
and Hon. Life Membership of the RPS; he
continued much of this work for years after
receiving the award.
RPS DIGIT Magazine 2014 Issue 3
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John is still involved with Assessments in
that he is a Panel Member of the Disabled
Photographers Society Assessment Panel for
L, A and F Distinctions, is the Administrator,
receiving and returning submitted panels
and sees everything is in place to ensure the
Assessment days run without problems.
It is impossible to list all John’s
achievements and contributions
made continuously for 60 years to ‘the
photographic world’, so it gave me much
pleasure to see the presentation of the
‘Hon. DIG’ Certificate to John, this true
gentleman who so richly deserves it. I count
myself very lucky to have such a true and
loyal friend, and know I am just one of many
who value his friendship.

!j. . . . . . . . . . . . . . .,____

................................
All images on pages 6 and 7 are by John Long

Dragon Sisters

!
j
Evening Fishing

Harley Man

Hank
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Smiling in the Rain
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VIVECA KOH FRPS

LAYERS OF MEANING:
A CREATIVE APPROACH

Siren’s’ Song

Viveca Koh explains how the commission to illustrate her uncle’s book
of poetry and prose eventually developed into the basis of her recent
successful FRPS panel of 20 images, some of which are illustrated
here. She describes how she uses texture layers and multiple overlays
in Photoshop to combine various images together to make the final
images that please her.

I

have considered myself to be a fine art
photographer for a few years, mainly
based upon the fact that many of my
photographs have evolved and developed
gradually over time into artistic and quite
painterly images, as I began to experiment
with the use of texture overlays and
multiple layers in Photoshop. This technique
8

currently forms the basis for all of my
work, although I expect it to change in the
future, as I enjoy trying different techniques
and have no wish to become stuck in a
photographic rut. Seeing is a huge part of
the photographic experience but expressing
that vision is also very important to me,
and I believe that there are many ways of

doing this. As I learn more about Photoshop
I realise how much potential there is for
processing photographs in different ways
and how I can utilise the programme to
bring my ideas to life.
Having said this I always try to get the
initial photograph right in camera,
RPS DIGIT Magazine 2014 Issue 3
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especially when it comes to exposure
and composition. One of the things that I
love so much about taking photographs
is firstly spotting my subject matter and
then deciding how to frame it within
my camera’s viewfinder. It might sound
daft but this part of the whole process
is immensely enjoyable for me, and I am
always so absorbed when I am taking
photographs that I am barely aware of
anything else, yet the post-production
work that follows is equally pleasurable.
I’ve heard some photographers say that
they cannot bear the computer-work
element of digital photography and they
will spend as little time on it as possible,
making the minimum number of tweaks
and adjustments, but I love it as much as
the actual picture taking – I regard myself
to be quite fortunate in that respect!

Shop Window

As a photographer I am very attracted to
the details, the smaller parts of a whole
picture, sometimes insignificant and
overlooked elements and also things
that others might find less savoury –
dirt, decay, dead things and dereliction,
which seem to have a strange pull on my
attention. I have a tendency to incorporate
all of these into my work quite frequently.
Over time I have collected quite
an extensive database of my own
photographs that I use as overlays, which
includes subjects such as skies, fabric,
old wallpaper, cracked and peeling paint,
postcards, documents of varying types to
name but a few, and I will use these as a
separate layer over my base photograph
in Photoshop. Some of my layered images
are relatively simple, containing no more
than half a dozen layers, others can be
more complex, but all generally feature
the use of layer masks which is the method
I use for the fine blending of one layer with
another.
I had been perfecting this combination
of ideas and techniques for a few months
when my uncle commissioned me to
illustrate, in a book, his latest collection
of poetry and prose, after he saw one
of the books I had previously created
and self-published via Blurb. This book
‘Star Blossom’ was to become the basis
of my Fellowship panel although I didn’t
immediately realise this, and it was
only when I had produced a number of
illustrations for the book that I thought
they might be of the right standard.
From a personal perspective, I felt that
they were sufficiently different from my
Associateship submission (gained in June
2011) but, more importantly, much further
evolved in demonstrating my vision and
creative development as a photographer.
RPS DIGIT Magazine 2014 Issue 3

Translation

His Heart Listens
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Someone asked me very recently whether
I have an idea in my head when I take a
photograph as to how I will process it when
I sit down in front of my computer. The
answer was no, very rarely does this happen,
I will usually only decide which textures and
additional photographs I will add to another
once I review the photos in Lightroom and
decide firstly which ones to develop and
secondly how to approach this.

With Imprisoned Wish

Some of my photo illustrations for the book
were fairly literal interpretations of the
poetry and prose, and required me to go
out and photograph mentioned objects and
elements, such as the barbed wire (‘With
Imprisoned Wish’), a heap of junk mail
(‘A Mirror Wall of Words’) or the scissors
and comb (‘Star Hair’). For the latter I went
into the local barber’s shop and asked if I
could quickly borrow the tools of their trade
for a photograph to use ‘in a project I was
working on’, laid them on the table, shot
them in natural light and then off I went.
I’m sure everyone there thought I was a bit
peculiar.
‘No Echo’ is made up from a number of
separate elements, the background being
one of the cells at Bodmin Gaol, Cornwall,
combined with a telephone from an
abandoned house, a snail which I shot with
my iPhone and several photos of cracked
paint along with a layer of reversed text. I
am very partial to using text or writing in my
images, the actual words very rarely mean
anything but I like the way different styles
of lettering look in conjunction with the
pictorial elements.

Star Hair

I placed all of these elements on separate
layers, each using a Normal Blending Mode,
but once the textures come into play I
experimented with different Blend Modes to
get the effect I was after.
In the example of ‘No Echo’, the fibrous
texture layer uses Color Burn, the cracked
paint Overlay, the text Soft Light and the
blue paint Multiply.
If I need to make any changes to Brightness/
Contrast or Hue/Saturation for example, I
always use Adjustment Layers so that the
original base photograph is not altered
in any way. These can easily be turned on
or off, masked where necessary or simply
deleted if the effect does not work.

A Mirror Wall of Words
10

I make extensive use of masking as shown
in the black and white thumbnails on the
Layers Panel example, so that I am totally
in control of which parts of every single
layer affect the final image. These were the
fundamental techniques that I used for all
photographs in my panel.
RPS DIGIT Magazine 2014 Issue 3
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Layers Panel for ‘No Echo’

In this respect my use of Photoshop is
relatively simple. I consider it to be a giant
iceberg of a programme with lots going
on under the surface i.e. many tools that
one may never use. I am always willing
to learn more through extensive reading
and watching tutorial videos online, so I
wouldn’t surprise myself to be applying
some new technique to the processing of
my photographs in future that may give
them a completely different look and feel
to the one that I have now. I’m really happy
with that idea.
One of the aspects of using multiple
layers that I enjoy so much is the ability
to transform mundane objects into an
entirely alternative character, to something
unexpected and even beautiful in its new
context.

Other Lives

‘Other Lives’ features an oil painting portrait
of a woman that I photographed in a derelict
house, overlaid with a separate photograph
of a very ripped and ratty net curtain, which
made the circular pattern texture.
‘Sirens’ Song’ (See page 8) is some old
postcards layered with a shot of barnacles
on a rock by the sea, since the whole poem
is themed along these lines.
‘Star Loss’ shows a Christmas decoration
which I photographed without ceremony
against my study window, and then
superimposed it onto a separate rooftop
shot, with an additional ‘texture’ of
condensation on the side of a pint of beer to
mimic the same on the glass of a window.
RPS DIGIT Magazine 2014 Issue 3

Star Loss
11

VIVECA KOH FRPS

The sparkling bokeh texture in
‘The Princess’ came from my
fibre-optic lamp that I photographed
quite close up with an aperture of
f2.8 so that much of it was out of
focus. It gives me a huge amount of
satisfaction to ‘art up’ the dull, dreary
and unloved in this way.

The Princess

My hope for the panel is that these
twenty photo illustrations can be
viewed as a set of images that work
well together, pictorial in their own
right thus allowing the viewer to
make up their own stories to go with
them. When seen in conjunction
with my Uncle’s poetry and prose
they may become more ‘obvious’
and answer some of those questions
“why?”, but ultimately they are a
flight of the imagination, slightly
enigmatic and strange, asking the
viewer to look still further and to
think more deeply.

Viveca Koh FRPS
Fellowship Panel Layout

FRPS Panel Layout

12
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CLIVE R. HAYNES FRPS

THE GENTLE ART OF COMPOSITING
Clive Haynes, a past Chairman of the RPS Digital Imaging Group, is
very well known for his talks, lectures and workshops throughout
the country. He is primarily interested in ‘making pictures’ by using
photography as a medium of artistic expression. Here he discusses
all the aspects that need consideration, and some of techniques
that might be employed, when combining images together.

A

lmost since the dawn of photography,
photographers have sought to
combine images together. These
composite or montage pictures can be
made for aesthetic purposes, for reasons of
practicality or to produce a ‘vision’ that exists
in only the imagination of the artist.
Digital imaging affords yet more scope for
the photographer/artist.
Generally speaking, the more subtle the
combination the more pleasing the result.
However, some crude ‘cut and paste’
amalgamations can have a primitive delight
all of their own. It all depends upon what
you wish to achieve and communicate.
There are many considerations to be made
before one begins to combine images and
here are some thoughts:
The relative scale of the individual component
image
The textural integrity of each component
image
The direction of lighting for each component
image
The direction and possible addition of
shadows
The colour tone of each component image
The ‘sincerity’ of the overall picture

Scale of the individual images

If you are unable to photograph the images
for your composite picture individually at
the correct scale for the final result then
you will have to alter their relative size in
some way. Commonly, people simply re-size
the components via the Edit > Transform >
Scale route. A small amount of re-sizing is
generally acceptable, however this method
is not always the best answer, as pixels are
either invented or discarded in the process.
The final image can suffer a ‘definition
differential’ i.e. some parts being either
sharper or fuzzier than others - see ‘Textural
Integrity’ below.
It’s possible to overcome this problem to
some extent by ensuring, wherever possible,
that the individual images for the intended
composite picture are as close to the scale
required as possible.

Textural Integrity

There are two principal areas: ‘Noise’ and
‘Sharpness’.
‘Noise’
When combining images it’s considered
‘bad practice’ to combine a fine, virtually
‘noiseless’, low ISO (little or no ‘grain’) image
with a ‘noisy’, high ISO (coarse ‘grain’) image
in the same scene – well, if it’s discernible
that is. The problem is becoming much less
evident as cameras become less and less
‘noisy’ at higher ISO settings.

Most of the problems are best resolved
at the ‘taking stage’ by the art of
‘previsualisation’ - that is to say, wherever
possible, be aware of the final picture
you have in mind as you photograph and
‘assemble’ the various components for the
image.

Imagine a finely delineated landscape to
which a dramatic sky has been added. An
example would be where the sky originated
from a high ISO setting whilst the landscape
was taken at a low ISO value. The evident
granular quality of the sky would not sit
easily with the image. There would be a lack
of ‘textural integrity’ and the image would
be uncomfortable.

Taking the above topics one at a time, below
are thoughts and practical advice.

Should you be faced with the problem of
a too obviously ‘noiseless’ area in an image
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where the noise should be visible to give
some veracity, add some ‘Noise’ via, Filter
> Noise > Add Noise; however do this on a
separate layer. A better and more flexible
method is to make a new (empty) Layer
above the problem Layer, fill this with 50%
Grey (In Photoshop via Edit > Fill > Use >
50% Grey > OK). Everything will go grey!
Next, change the Blend Mode for this Layer
from ‘Normal’ (top LH of Layer Palette) to
‘Overlay’ (image returns). Next: Go to Filter
> Noise > Add Noise, choose ‘Gaussian’ and
tick ‘Monochrome’. Adjust the amount to
integrate with the image. You can alter the
opacity of the Layer and add a Layer Mask to
refine the area.
‘Sharpness’
Make certain that the components of the
image appear to be part of an original scene
both in terms of texture and sharpness.
Avoid images that look too sharp for their
surroundings, and if necessary use softening
or blurring to subtly reduce sharpness.

Direction of Lighting

As fundamental as it may appear, many
multi-image pictures are ruined by poor
attention to lighting and shadow details.
Indoors or under artificial lighting where
there are multiple light-sources you may get
away with it but outdoors in daylight, where
we expect there to be just the one light
source i.e. the sun, two or more shadow
angles will bring the image into question.
Don’t forget the direction of the ‘key light’, as
the highlight-side of the area you’re working
on may also need attention to render the
image convincing.
Problems with lighting direction can
sometimes be easily overcome by flipping
the image horizontally via Edit > Transform
> Flip Horizontal. However ‘flipping’ also
reverses any writing, rings on fingers
(watch-out Wedding Photographers!),
breast-pocket handkerchiefs, watches, etc.
13
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If it’s really difficult to change things
without it looking obvious – and
Photoshop can’t help with everything –
and if you’re in any doubt – don’t risk it
– someone will notice the error, so choose
something else or shoot the required item
again.

Shadows

The Op’s Room - Original Image

Sometimes the original shadow will need
to be stripped away (possibly by using a
Layer Mask) and a fresh shadow added.
More complex shadows can be added
by isolating the subject and applying a
new shadow derived from its shape and
adjusted via Edit > Transform options.
However, frequently, the simple expedient
of ‘painting in’ can work very well. Add a
new, empty Layer above the subject and
use a soft-edge brush tool at the required
size to gently paint in the shadow.
‘Painting-in’ is easy for a general dark
shadow cast on a bright or overcast day
but much more demanding under harsh
light. A Layer Mask can be added to the
‘Shadow Layer’ to carefully edit the work.

Colour Tone

The Op’s Room - Edit Image

This is a similar problem area to lighting.
If you’re bringing in different images,
shot at different times, with different
cameras, different settings, indoor/
outdoor etc., then it’s inevitable that you’ll
have to make some adjustments to these
individual components of the picture. If
possible make these adjustments at the
RAW editing stage either in Lightroom or
Adobe Camera RAW.
If you have to work on post RAW images
or jpegs then make these adjustments
with an Adjustment Layer for each image
concerned. You’ll need to make a ‘Clipping
Group’ for each new image layer.
Use one of the following to make these
changes and it can be tricky:
Hue/Saturation
Color Balance
Channel mixer

Sincerity

This is probably the most difficult item
to discuss, as Photoshop certainly has no
such function in its program.
Sincerity is about what you are making
with your image and what you intend.
Whilst it’s true to say that in art there are
really no ‘rules’, only ‘conventions’, think
seriously about what you are doing –
stand back for a moment and consider:

The Op’s Room - Final Image
14

Is the effect you’re striving to achieve rooted
in some form of reality?
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Will it confuse or intrigue the viewer?
Is the overall effect merely an effect for
its own sake – in the “I can do it, so I will –
aren’t I a clever person!” school of art?
Yes, we’ve all done it, we’ve all been there
and we’ve all seen images of strange and
distorted faces and wings fitted to things
and the like.

Think to yourself:

When I’ve completed this picture, will it add up?
Will it tell us more about the object/scene/
emotion/person portrayed or extend our
knowledge in some way?
Will it be amusing and intriguing or simply
weird and confusing?
Will it be true to its own internal logic?
When entering the realm you’ve created, will
viewers willingly suspend their disbelief?

No Escape - Original Image

No Escape - Stairs

No Escape - Ceiling Light Correct Exposure

No Escape - Final Image

Sincerity is a vast issue and there are no
black and white answers, only shades of
grey.
The important thing is not to get carried
away with an idea or series of effects
for their own sake. Try to remain faithful
to your internal vision and not to be
sidetracked by the weird and wonderful
things you can superimpose on a scene.
The most telling pieces of work are
those with a simple and direct message,
delivered in an uncluttered way.
The intrinsic problem with making the
statements above is that many examples
can be found that appear to contradict
them. At least I hope I’ve made you stop
and consider.
Finally, when you’ve completed your
masterpiece, leave it for a while then
return to it. If when you view it your
conclusion is: “that’ll do” – it most
certainly won’t. Be critical; others will be
less forgiving. Exercise ‘quality control’ at
all stages.
Remember, what you’re aiming for can be
summed up in just seven words, “Fidelity
of representation with insistence upon
detail.”
For more information about Layer Masks,
Adjustment Layers, Adding and Managing
Shadows, visit the Know-How section of
my website at www.crhfoto.co.uk

RPS DIGIT Magazine 2014 Issue 3

15

ADRIAN DAVIES ARPS

Digital BEGINNINGS
Adrian Davies remembers the origins of the Royal Photographic Society
Digital Imaging Group and gives us some insight into why it was
formed and what its purpose was. He also reflects on the difficulties of
digital imaging in the early years.

A

round a year ago I left my full time
post at NESCOT College in Surrey,
to concentrate on my other career
as a freelance wildlife and natural history
photographer and author. During my
time at NESCOT I set up and ran several
unique and innovative courses in Electronic
(Digital) Imaging, as well as working with
organisations like the RPS to set up their
Digital Imaging Group (DIG).
I do not have the date to hand (perhaps
a reader can help?) but I do remember
one Saturday afternoon travelling to the
Soroptomist Club in London, with around
12 other RPS members to discuss whether
there was a need for a new RPS Group in
Digital Imaging. Amongst the participants
were John Henshall and the late Barrie
Thomas. A lively discussion ensued when it
was decided that there was indeed a need
for such a group, though only perhaps for a
couple of years. The main aim of the group
was seen to educate the other groups into
the new technology of DI, and that its job
would be done after that! No one quite
foresaw the creative possibilities of the new
technology, which we see in places like
DIG today, and make it the fastest growing
group in the RPS.
My own courses at NESCOT started in 1991
with an HNC in Electronic Imaging funded
by a government scheme aimed at retraining unemployed photographers and
graphic designers in the new technology.
With one 640 x 480 camera (costing around
£2.5K), a monochrome 300dpi scanner, and
5 Apple Macs we ran the first course. There
were no textbooks, and no Internet, so
finding information was always a struggle
for both staff and students. Despite all this,
the course was very successful, and ex
students found jobs at Kodak, Nikon, and
various hospitals and museums, often as
scanner operatives. Many are still working in
the industry today.
NESCOT was the first college in the UK, and
probably in the world outside of the US, to
run full time courses in digital photography,
and manufacturers were often knocking
16

on the door with offers of new kit to try
out or visits by their staff. Within a couple
of years we were trialling the new Kodak
D100 camera, Photo CD, and Kodak Dye
Sublimation printers, all hugely expensive
pieces of kit!
IT was always a challenge, particularly in a
PC based college. Our oasis of Apple Macs
was always seen as a nuisance by the rest
of the college, though I suspect much
of this was based on jealousy! I still have
nightmares about our struggles with SCSI
chains, Syquest discs and RAM costs. I also
still vividly remember the first time we
transferred an image, on 3.5” floppy disc,
from a Mac onto a PC and viewed it on a PC
screen in an early version Photoshop. The
college was hooked, and everyone wanted
Photoshop on their PCs.
I am forever staggered at the quality of
images from the early cameras, even from
the early 1990’s. I still have images from the
DCS 100 of flowers that I shot which easily
print to A4. I have recently re-processed
some of those early images in modern
software (Adobe Camera Raw) and am still
pulling out detail that was not present in
the early prints. Kodak in particular also
encouraged us to test the cameras for
other techniques – infra red and ultraviolet
imaging, and high speed.

Fig 1

If ever there was a technology ahead of its
time it was Photo CD. For 60p per image you
got 5 different resolutions of scan from a
35mm negative up to 18Mb (the Pro Version
also gave a 72Mb file for a few pounds each
from other sizes of original). Market uptake
was low though, and with home scanners
becoming common, the technology was
abandoned.
The Dye sublimation print process was superb
too, though expensive, using three whole
sheets of coloured acetate the same size as
the print. I still have some from the 1990’s, and
they are still as vibrant as ever. The technology
was soon overtaken by ink jet, with the results
we know and love today.

Fig 2
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Software was always a bit of a struggle in
the early days, particularly with Macs or PCs
only having perhaps 4Mb RAM, and 40Mb
hard discs! Originally there were two main
imaging software titles, Adobe Photoshop,
and Letraset Color Studio (which had a
layers facility from day one). Both were
expensive, and we needed to decide early
on which one we were going to stay with.
Fortunately we made the right choice with
Photoshop because Color Studio eventually
vanished.
The early 2000’s saw a rapid rise in the
number of cameras, a fall in prices, coupled
with huge advances in IT (cheaper RAM and
storage etc.)

Fig 3

In 1993 I was contacted by Margaret Riley
from Focal Press to see if I might want to
write a book for them on Electronic Imaging.
As might be imagined, with no other
material available (other than magazine
articles, particularly by John Henshall)
this was a rather daunting task but, with
ex student and friend Phil Fennessy, we
produced the book, published in 1994. It
became highly successful and went on for
4 editions, and was translated into several
European languages. For the first edition
we wanted to include some innovative
technology – a CD ROM containing images
from a variety of cameras. We produced this
ourselves, but soon fell foul of compatibility
issues, with some readers with older PCs
complaining that they could not open the
images. A second disc was produced and
sent out, but it was a rather salutary lesson!
Fast-forward to today: with a plethora of
high resolution, multi function cameras it
is difficult to know where the technology
will take us next. It is now possible to get
cameras that do not require focussing,
have in-built GPS, built in ability to produce
HDR and panoramic images, broadcast
quality video, and send images to the
internet. We live in a very different world
than that of fifteen years ago, with social
media providing a platform for all manner
of types and levels of photo imaging. A
very sobering statistic that I found recently
(though not sure of its accuracy) is that
more photographs have been taken in the
last 5 years than in the rest of photographic
history! I’ve had an exciting time, and will
surely continue to do so!
Adrian has a large collection of digital
cameras and other paraphernalia, which he
has started to show to camera clubs. Please
contact him by the email below if you would
like to discuss a visit:
adaviesimaging@gmail.com
www.adriandaviesimaging.com
RPS DIGIT Magazine 2014 Issue 3

Fig 4

Fig 5

Fig 6

Fig 7

.....·--····

Captions:
Fig 1. Passion Flower (Passiflora x rosea). The
detail in the flower is superb. Kodak DCS 620
Fig 2. Calla Lily (Zantedeschia aethiopica)
photographed with the Kodak DCS 620 DSLR in
1998. The subtlety in the foliage is remarkable.
Fig 3. Adrian Davies with the mighty Kodak
DCS 100 camera. There was no room in the box
for a lens.
Fig 4. A Photo CD dating back to 1992 – truly a
technology ahead of it’s time.
Fig 5. Balloon at the point of bursting. Flash

:..............

.... - -...

.....,-.....

:

duration approx. 1/10,000 second, open flash
technique. Shock waves made visible by use of
small amount of talcum powder inside balloon.
Kodak DCS 620
Fig 6. Jade Vine (Strongylodon macrobotrys)
the remarkable, unique colour of this plant,
photographed at the RHS Garden at Wisley, has
been faithfully reproduced by the DCS 620.
Fig 7. Infra-red shot of grandstand at Epsom
Downs. Unmodified Nikon Coolpix camera.
c.1997

...........·--··
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SHEILA HAYCOX ARPS

MY PHOTOGRAPHY
Sheila Haycox enjoys attending photographic workshops that
involve a few other like-minded people, getting inspiration and
guidance that she can put into practice when going out on her own
or with friends. She has a wide range of photographic interests
including landscapes, natural history and street photography.

Yorkshire Dawn

How My Photography Has Developed:
Room for improvement: “yes, always”. I am
never satisfied; I think I have the perfect
shot, process it, look at it, change my
mind, think again, then think, “so what,
just another image”. I have produced
a few decent images and I think the
reason for getting some good results was
photographic workshops combined with
looking at images that have done well in
salons and exhibitions: a good source of
inspiration.
18

Photographic Workshops: I have, over the
years been on a fair number. My first one
ever was in the late nineties as a newbie
to photography; I remember it so well. My
husband thought it would be a good idea,
so I took my car and drove all the way to
Northumberland from Devon. No Sat Nav
in those days. I had yellow post-its stuck all
over the dashboard as indications of my
route. There were 10 of us, we stayed in selfcatering cottages and the two leaders took
us to the ‘right places’. It was a lot of fun but

not a holiday. It was very tiring with long
days as we traipsed around all the places
that to me were fantastic and so completely
different to anything I had taken. But it
was also a great learning experience in the
use of tripods, getting to know the camera
and of course the most important part of
photography: lighting. With so much expert
advice I was on a high. I was using a film
camera then but the techniques are still the
same. My eyes were opened and there was
no holding back. My biggest problem was
RPS DIGIT Magazine 2014 Issue 3
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Three in a Row

Pelican Reflection

Melee
the drive home; I was so tired from a tough
week that I had to keep stopping for a quick
nap.
I now go on workshops that in the main
only have three photographers; this gives
us more opportunities to go to places
where it’s difficult to set up tripods in tight
RPS DIGIT Magazine 2014 Issue 3

situations. Also we each get that little more
attention from our ‘expert’. In the main I
have opted for landscape workshops but
have been on Birds of Prey, Irish Seabirds,
Seals and Dalmatian Pelicans – my latest
and certainly the best, as my skills have
improved and I managed to get so many
good images.

I have been fortunate in getting the right
person running a workshop. What I find so
good is that he knows exactly where to go
whatever the weather; if there is a sudden
change of light then we drive off into a
different direction. I get plenty of advice
which has been put into practise when I
have gone out with friends on other trips.
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Tulio Rearing

Tulio and Jon

My Own Style: I do have the opportunity of
‘doing my own thing’ in the hope of getting
something different, which I certainly did
recently. I was out taking bluebells and this
white horse and bareback rider appeared.
How lucky is that!!!!
I still do workshops, as it’s a very good way
to be with other people of like mind and
very often I meet up with some of them
again on other workshops. It’s certainly the
ideal for those who live on their own but
want good photographic company.

Inspiration: Yes, I am inspired to do
something different. I get ideas from
talks given by renowned photographers,
studying successful images in salons and
exhibitions, going out of my comfort zone
and trying other genres. I have started
doing more creative work and lately have
been inspired by Steve Le Provost who I
greatly admire; but I do intend developing a
style of my own.
Projects: I now do more projects, which
came from doing Holsworthy Livestock

Trotting Through the Bluebells

Market. I photographed the auction and
auctioneer, farmers, livestock and buildings.
I was given free range of the market, so a
varied selection came from this, which gave
me the idea of using them for an ARPS panel
and I was highly delighted to gain my ARPS
distinction from this project.
What next? I am still striving for that “wow”
image but all that really matters is: do I like
what I am doing and I can honestly say, “yes”.
It doesn’t matter what everyone else thinks
as long as you enjoy what you are doing.

20

ARPS Panel
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Bareback Rider Impression

Ozzie’s Patch
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ANDY BEEL FRPS

Allowing perception to mature
Andy Beel FRPS is an entertaining speaker on the circuit and he
gives us a few insights into the picture editing process by allowing
pictures to mature before post-processing and not deleting files at
the earliest stage. He then moves on to combining awareness and
perception with a post-processing plan to achieve a picture with a
dominant element that speaks to the viewer at an emotional level.

Evening Landsvirkjun Bjarnarflag Iceland May 2011 – digital Lith interpretation

Y

esterday evening I was giving a talk and
was asked about the picture editing
process. As photographers we like to
look at our captured pictures as soon as we
get home from a shoot, which only goes to
show our enthusiasm for our art and craft.
We can be easily lulled into a false sense of
insecurity by selecting those pictures with
immediate impact and processing them for
sharing with others, or printing or whatever

22

we do with our particular pictures, whether
we are a professional or amateur. The
professional will have an urgent need to put
the proofs in front of the client as quickly as
possible.
The amateur however doesn’t have that
time constraint and pressure; it can be a
very good thing to allow a period of grace
between taking the pictures and then
editing for post-processing. That period

of grace is a time of maturation when the
pictures that we have taken mature on our
hard drives. The files do not actually change
but our perception of them does.
When we leave our pictures for a while, we
lose the immediate effect of what we think
we’ve done, the excitement and emotion,
which we had at the picture taking stage.
We forget about the other sensory inputs
that we’ve had as we pressed the shutter
RPS DIGIT Magazine 2014 Issue 3
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Original RAW file before processing
release such as how the wind blew, the
fragrance of flowers that were there, what
we heard – birdsong etc etc.
All other sensory input apart from the
visual fades in this period of grace. What
is left in the end is the file – the actual
values of brightness in front of the camera
lens because that’s all that the camera
can record – brightness. It doesn’t have
any emotional sense such as memory
or a pool of photographic templates to
which it has to conform. Cameras have no
emotional intelligence, memory, perception
or awareness – that’s your job as the
photographer.
This period of grace leaves us in the end
with the cold facts of what we actually
did without the romanticism or what we
thought we did at the taking stage. It allows
us to see things as they really are, for good
or ill. Occasionally, after a shoot, when I look
at the pictures I will be disappointed with
what I’ve done. Then perhaps I will look at
them again after a while, months or maybe
years later, and then I can truly see them for
what they are – good or bad and in some
very rare cases masterpieces appear, but in
most other cases they don’t.
So it’s probably wise not to delete files
straight away off of your hard drive but
allow them to mature for months or
years and then come back to them later
with a clear head and insightful vision
that isn’t marred by the excitement and
preconceptions of the day.
The shot on the left-hand page opposite
RPS DIGIT Magazine 2014 Issue 3

was taken at Bjarnarflag, Iceland May
2011. It’s been sitting and maturing on
my external hard drive for over two years
unnoticed and unloved.

about what it is in these people’s work that
attracts you and why. How are you going
to enhance your visual perception from the
insights these people are showing you?

Above on this page is the RAW colour
original without any post-processing, the
place where I started in Lightroom.

Who was it who said “computers are useless,
they only give you the answers” (not asking
the perceptive questions): – Pablo Picasso.

Lots of photographers like to see the before
and the after pictures and so this is an
example. It just gives you the bare facts of
where I started in Lightroom so my files are
no different to yours in that respect - dull
and flat. Low contrast files at the taking
stage is a good point to start. Beginners
tend to think that you need a bright sunny
day to take pictures. Experience tells me
that I want a low contrast file that I can
interpret in my own style and add contrast
in the post-processing.

A free top tip – make a Post-Processing
Plan for the picture you want to enhance
BEFORE you move ANY sliders in the editing
software. In your post-processing, plan in
your head the answers to the following
questions:

Unprocessed RAW files are fairly
unimpressive beasts, however they have
huge potential for being processed in any
way you can imagine.
Awareness and perception are key factors
here, long before the mechanics of pressing
buttons on a computer keyboard is
involved. If you cannot see a potential final
image or recognize a problem, how will you
be able to create it or fix it?
Who or what do you aspire to? Who are
the photographers that create the pictures
that give you pleasure and satisfaction?
A challenge for you – make a list of all the
photographers, dead or alive, working in
any medium that inspires you. Now, think

1 – What do I want to say about the subject
to the viewer, what is the attraction, why
might they be interested, do you have
anything new or different to say?
2 – What is the subject of the picture and
how are you going to give the subject
matter dominance in the picture space in
the post processing?
3 – How are you going to create a tonally
balanced picture?
4 – What needs to cropped out, lightened or
darkened, have an increase in contrast etc?
In this wide ranging article we have looked
at not deleting files before they mature,
RAW files have the potential to be processed
in any way you can imagine, where does
your inspiration come from and how are
you going to use that stimulus to affect your
own interpretation of a picture.
Go online now to see more of Andy’s work
at www.andybeelfrps.co.uk
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DAVID BROWNRIGG

PHOTOGRAPHS TO COMPUTER
ART VIA TRANSFORM SPACE AND
DIGITAL FILTERS
David Brownrigg’s interest in photography extends back well over
fifty years, and he has belonged to photographic societies as far apart
as Edinburgh and Jamaica. His interest in using computers for image
making and art began with computer graphics over forty years ago
and developed with image processing in the early 1980s, including use
of non-linear filters for brush and texturing effects. The current work
stems from long-standing interests in computational physics where
convolution processes, that are used in solving gravitational field equations and structure
analysis, require use of fast Fourier transforms and processing in that space. Background
reading for his article is listed in a short bibliography.

I

first realised how great the potential was,
for combining novel computing methods
and photography, in the early 1980s when
working on astronomical image processing.
I had access to a raster colour device with
sufficient resolution and colour range for
visually acceptable display of more general
images. Also, my computational astronomy
background gave me an appreciation of
how simple changes in the discrete Fourier,
or other, transform of a digitised image
could give interesting effects in the image
itself – changing one value in the transform
results in changes to each and every pixel of
the final image.
For example, Figure 1 is a simple scene,
while Figure 2 shows the result of some
transforms that affect the image extensively.
Details of this process are given later as part
of a progression through simple changes
that allow parts of the original image
to be recognised, to increasing levels of
processing that give a range of abstract
effects.
Recently I have been experimenting
with several approaches to transform
space changes. These include (a) basic
manipulation of the transform space
modes for a single image, (b) combining
the transform space modes for a pair
of images, (c) working with stacks of
images or movie frames, both as sets of
two-dimensional transforms and a three24

Figure 1
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Figure 2

dimensional transform of the image stack,
and (d) combining transforms to give a wide
range of effects. I use Processing, a language
built on Java, to program both standard
transform algorithms and novel facilities, to
give me full control over effects.
While some mathematics underlies these
transforms, the essential features can be
appreciated more generally. Typically, each
pixel in a digital image is represented by
three values, such as RGB or HSV, so an
image can be processed in three separate
parts, row by row and column by column,
each a sequence of numerical values. For
comparison, a digitised sound sample also
gives a sequence of numerical values. This
sequence can be considered to be made
up of a combination of frequencies, each
RPS DIGIT Magazine 2014 Issue 3

having a specific wavelength and amplitude.
A given wavelength/frequency of the sound
corresponds to its musical pitch and the
amplitude is a measure of its loudness.
In the same way, any of the three
components of a line of pixels, horizontally
or vertically, in a digital image can be
interpreted as made up of a combination of
waves each with an amplitude related to its
brightness. Different transforms work with
waves of different shapes, and interpreting
one transform in terms of another leads
to pictorial effects unobtainable with any
practicable method of processing images
directly. The transforms used are Fourier,
Walsh, Slant, Sine and Cosine. A brief
commentary on the relationship between
the transforms is in the Appendix.

Figure 3

Using different forward and reverse
transforms gives a complex effect that
depends on both the image and the
transforms. A small number of examples can
illustrate this, but can only hint at the range
of application.
Figure 3 is an example where the underlying
image is still largely recognisable, while
the effects go beyond simple blurring, to
include elements of the image replicated
at lower intensity elsewhere. The ‘modes’
representing the largest scale features of the
image have been kept unchanged, while the
shorter scale information has been encoded
by the Cosine transform and used by the
inverse Slant transform to contribute to the
final image.
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Figure 4

Figure 4 shows the use of a different
transform combination (Slant and Walsh,
used forward and inverse respectively).
There is now a complex pattern of horizontal
and vertical divisions, giving an image that
is quite far from the original while keeping
some recognisable aspects. These divisions,
characteristic of inverse Slant and Walsh
transforms, can in turn be modified if the
final image has shear distortion applied
horizontally and vertically, with either a
wave (sine-like) or saw ripple variation
in both directions as well. This, of course,
would lead to geometric distortion of the
global spatial relationships in the result,
but this can be countered by also applying
the inverse (reverse) shear and ripple to the
images before the initial transform. Mixing
the transforms, even on a single image, can
lead to much larger changes. Figure 2 is an
example of this, where a forward Cosine,
and inverse Walsh transform were applied
to Figure 1, with a shear and saw change
before transform, and its reverse after the
inverse transform.
As the different image components are
processed separately, they can be treated
differently. In Figure 5 the blue component
has been left unchanged while the red and
green have a forward Fourier and inverse
Walsh applied. In this case significant
colour separation results, as well as the
26

spatial divisions and repositioning of
image elements seen before. The colour
changes are increased by rescaling to the
display range separately for each colour
component.
As a last illustration of the various
transforms, Sine provides some significant
effects. Figure 6 results from using the
Sine transform and Slant inverse applied to
Figure 1. Unmodified, the Sine transform
‘burns out’ image edges, with values beyond
display limits. Instead of capping, as in the
previous figure the values range is rescaled
to the display range, separately for red,
green and blue components, giving some
striation effects near the edges of the image
and a high degree of abstraction, especially
when combined with shear and sine-wave
modification that rearranges the horizontal
and vertical divisions from the transforms.
Some of the images are both abstract
and decorative, but represent only a small
part of what can be achieved. Not least,
the effects of any transform combination
depend heavily on the source images. Here
only a single starting picture has been used.
Results with pairs of images or stacks of
movie frames enable even more diverse
effects. In practice the possibilities are
limitless.

Figure 5

Appendix
Any sequence of pixel values can be
interpreted as the sum of a set of waves
or modes, of different length, each mode
having a particular amplitude value. The set
of mode values exactly describes the line
of pixels, and the original pixel values can
be reconstructed from the mode values by
taking the inverse transform.
As shown in Figure 7, the discrete Fourier
transform decomposes a sequence of
values into the amplitudes of a set of sine
and cosine waves, the Walsh transform
does the decomposition in terms of a set
of square waves, and the Slant transform
in terms of ‘saw-tooth’ shaped waves. The
Cosine transform interprets the data values
as though they have a mirror reflection in
the right boundary, while the Sine transform
interprets the data as if it were reflected
and negated in the right boundary. This
means that cosine and sine waves that
repeat over twice the data length are
the basic frequencies for the Cosine and
Sine transforms respectively. Pixel values
forming a basic curve for one transform will
be transformed to a single mode of that
transform.
Figure 7 graphs the first few modes for each
of the transforms. Each basic wave, or mode,
RPS DIGIT Magazine 2014 Issue 3
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Figure 7 - Transform basis functions by crossing number
NB All scaled zero crossing basis functions have a maximum amplitude
of unity, and with that scaling all the basis functions have a maximum
amplitude range of [-1,1] excepting Slant, where some absolute values
exceed unity. Thus the slant transform graphs have been differently scaled,
to an amplitude range of [-2,2].

Figure 6

changes sign (+ to -, or - to +) a different
number of times, so the basic waves can
be ordered by this ‘crossing number’.
When using different forward and inverse
transforms I relate different transforms to
each other by associating their basic modes
with the same crossing number.

obtain the two-dimensional discrete
transform (and in depth through a stack
of images for the three-dimensional
transform). It is this set of values we can
manipulate, or combine with transforms
of other images, before taking the inverse
transform to obtain novel images.

Figure 7 also shows how the different
transforms are related in terms of their
action. If a single mode is used in the
inverse for any transform, what emerges
is the corresponding basic curve for that
transform. For example, if a simple image is
white on the left half and black on the right,
there is a brightness step change half way
across. If the values are input to the Walsh
transform, it recognises that step change as
fitting its basic mode for crossing-number
1, and represents the pixels by that mode
with a value defining the step size. If the
mode data are used by the inverse Fourier
transform, then the final result is a sine
wave change in brightness, as that is the
corresponding curve for the same crossing
number. For any starting set of pixels we
generally end up with very different pixels
values - a major transformation where each
starting pixel contributes to every final pixel.
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LEN CLAYDON LRPS

DIGIT CHALLENGE: HEADS IN THE CLOUDS

Head in the Clouds

H

eads in the Clouds is one of a number
of creative/altered reality images that
I have produced over the past couple
of seasons. The original image was taken
in Barcelona with a Fuji bridge camera,
one of a number of images taken that day
of various street artists. It did take me a
considerable time before I actually decided
what to do with the image.

Original Image
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I did not keep the PSD file therefore cannot
show the process carried out, however
the stages were quite straightforward. The
original shot was of head and shoulders
only. Having decided on a square format, I
created a new canvas of the required size
and then added layers of clouds together
with a little noise.

The main image of the street artist was
then cut and pasted to the cloud layer three
times. The unwanted parts of the three
heads were then carefully rubbed out and
the scale of each head altered to create a
diagonal. The whole process took about an
hour.
At club level the image did OK in
competitions but at national and
international level has won a number of
awards including a Silver Medal at the GDPU
(Glasgow District Photographic Union)
National Digital Exhibition 2014 and a Gold
Medal at the Cork International Salon of
Photography 2014 in the creative class.
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GARY SHINNER LRPS

DIGIT CHALLENGE: SPIROGRAPH #1

Spirograph #1

T

he image you are looking at above,
is of a fairground ride, a tower-like
structure, and the resulting image
has been achieved in camera – yes,
that’s right, all in camera. I went out to
the Winter Wonderland and took some
images and messed about “as you do”.
Another example is shown on the right.
I was using a Manfroto tripod and a
Pistol grip of the same make. I had been
monitoring the ride for a short time and
decided to place myself below the tower
on the concourse and looked up at it.
Then I gauged that, when the ride had
reached its peak, I should try to time the
decent down. The angle I positioned the
tower in the viewfinder was in the left
corner going at an angle to the right!
The exposure was 16 seconds at F22;
I pressed the shutter at a time when I
thought the ride was going to descend
down, allowing this to happen.
I then used the pistol grip and swung it
RPS DIGIT Magazine 2014 Issue 3

around on the ball joint all the way to
the right, to try and mirror the starting
position!
(Note: I wasn’t able to tell how far I had
moved across or what the result would
be – I clicked off the B shutter and low
and behold, this is what I captured,
once it had saved itself to the SD card.)
There was some glare at the bottom of
the frame, which I cropped out, a slight
tweak to the saturations and levels but a
small amount. The crossing towers was
the cool result and the white swirling
lines were the individual lights on each
car revolving around the tower and at
the same time lowering downwards.
I think it’s quite a unique trick and
produced a rather creative ‘different’
effect of fairground rides.
I doubt it can work on all of them, but
worth the risk factor and time in trying –
all good fun.

Tower Twister #1
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SOME VERY Basic Tips FOR
DIGITAL PHOTOGRAPHERS
You probably know all of these, but do you actually put them into practise?

It might seem obvious but - get it right in the camera
It’s much better to get it right in the camera than to
assume you can put it right on the computer. Trying
to correct errors can mean a long time in front of a
computer screen. If your image is not sharp when you
take it, it will never be sharp.

Have a backup strategy
If (like me) you have ever had a computer crash before
you backed your work, you will already back it up
regularly.

However, if shooting RAW, overexpose rather than
underexpose, especially for dark subjects and shadow
detail, because you will have less noise.

External hard disks are relatively inexpensive to use
for backing up. You can do this manually or buy
software to do this for you. It is a good idea to back
up to at least 2 different places in case of disk failure/
corruption.

Tip for viewing an image destined for projection
Most competition software projects the image on a
black background. To preview it, with the image open
in Photoshop, press the F key and ‘toggle’ until the
image appears against a black background; the result is
sometimes surprising.

Printing tip
If you don’t know which side of the paper is the
correct side for printing, slightly moisten the tips
of the thumb and forefinger of one hand. Gently
squeeze only the very corner of the paper and release
your grip.
The paper will stick to your finger or thumb on the
side which will be printed. Put the paper into your
printer with this side showing – printing side up.

Learn some keyboard shortcuts
They might seem difficult at first but they will save you a
great deal of time in the long run. If you go to the dropdown menus at the top of the screen in Photoshop you
can find out what they are. Some of them are the same as
in other programs such as Word or Excel.
For example:
File>Save is Cmd S (Ctrl S on a PC)
Use this regularly to avoid losing any changes to your
image. But avoid ‘saving’ a jpeg file; always use ‘save as’ a
psd or tif file.

Crop progressively and review in the History Palette
The way that I decide how much to crop is to crop
progressively in Photoshop and then click backwards
and forwards in the history palette to compare the
different crops one after the other. Sometimes it helps
to view the image at less than full screen to get the
overall compositional effect.

Let me know whether any of my tips have helped.
If you have a tip that you think might be useful,
send me an email: digiteditor@rps.org
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IN PREVIOUS ISSUES
A searchable, cumulative contents list of previous issues 41-59 is available
from the DIGIT Group Magazine page of the Group’s website at:

DIGITAL
IMAGING

UPCOMING DI GROUP EVENTS
Details of all DIG events are available on the Group’s website at:
www.rps.org/special-interest-groups/digital-imaging/events

Some future events include:
DI Group Thames Valley
Sunday 19th October 2014
Woosehill Community Hall, Emmview Close,
Wokingham RG41 3DA
Final details to be confirmed – please check
website.
DI Group Annual Print Exhibition
01 October 2014 – 31 October 2014
Smethwick Photographic Society
Club Rooms, The Old School House,
Churchbridge, Oldbury B69 2AS
A wide cross-section of work from members
of this RPS Group. The Exhibition is this
year’s Selectors’ choice from all of the prints
submitted, with at least one print accepted
from every entrant. This Exhibition will travel
to various venues in the UK.
PLEASE NOTE that the dates for
this exhibition venue are currently
PROVISIONAL, and that opening hours are
yet TO BE CONFIRMED.
Contact: Marilyn Taylor ARPS
Email: digexhibitions@rps.org
Cost: Free
DI Group Southern Centre: David
Mallows- Adobe Photoshop Workshop
Sunday 16 November 2014
Greyfriars Community Centre,
44 Christchurch Road, Ringwood, BH24 1DW

This lecture workshop is aimed primarily
at intermediate to advanced users of
Photoshop and a working familiarity
with the menus and use of layers will be
anticipated. Topics covered will include as
time permits: Adobe Camera Raw adjustment tools
•
Advanced layers and layer masks
•
•
Retouching tools for portraits
Selections
•
•
Creating composites
•
Adjustments using frequency
separations.
David Mallows is a professional
photographer and re-toucher. He is an
Adobe Certified trainer. Many of the
examples used for demonstration will be
from his professional work.
Time: 10.30 – 1600
Contact: Dr Barry Senior Hon FRPS
Email: digsouthern@rps.org
Cost: DIG Members £6, RPS Members £10,
Non RPS Members £10
Booking Form: Download from website
Advanced Booking Strongly
Recommended
DI Group Thames Valley: Member
Presentations + Millennium Cup
Competition for Prints
Sunday 23 November 2014
Woosehill Community Hall, Emmview Close,
Wokingham RG41 3DA

Millennium Cup Competition for Prints
“This year ... next year”: a summary by
your Centre Organiser
•
Open Forum – your turn to speak.
Time: 10:00 – 15:30
Contact: Laurie Pate
Email: digthamesvalley@rps.org
Cost: DIG Members £6, RPS Members £10,
Non RPS Members £10
•
•

DI Group Western – Gavin Hoey Live
Demonstration
Sunday 14 December 2014
Clyst St Mary Village Hall, Clyst St Mary,
Nr Exeter EX5 1BG

www.rps.org/special-interest-groups/digital-imaging/about/030-digit-group-magazine
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What better way to learn more about
the latest techniques in photography
and Photoshop than by watching a live
demonstration from Gavin Hoey? He aims to
educate, inspire and entertain. This is an all
day live demonstration special event which
is being held at Clyst St Mary Village Hall,
Near Exeter, EX5 1BG Lunch 13.00 – 14.00
and packed lunches are advisable although
there is public house and corner shop
nearby. Doors open at 10.00
Time: 10.30 – 1600
Contact: Janet Haines ARPS
Email: digwestern@rps.org
Cost: DIG Members £6, RPS Members £8,
Non RPS Members £10
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MEMBERS’ DIGITAL PROJECTED IMAGE
COMPETITION 2013

OPEN
30
Dawn Light by Pam Sherren ARPS
		
(Gold Medal and Raymond Wallace
		Thompson Trophy Winner)
31
Dawn, The Cobb by Stuart Crump ARPS
		
(Andy Beel FRPS Ribbon)
32
Snow Abstract by Carole Lewis ARPS
		
(Andy Beel FRPS Ribbon)
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Misty Winter Morning by Malcolm
		McBeath ARPS
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At The Ballet by Valerie Duncan ARPS
		
(Susan Brown FRPS Ribbon)
35
Don’t Do That by Ann Cole LRPS
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Butterfly Tree by Adrian Lines ARPS
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Venice Sketch 2, Valentine
		Kulagina ARPS
		
(Gold Medal and 		
		Chairman’s Cup Winner)
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		Cooke ARPS
		
(Walter Benzie FRPS 		
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(Guy Davies ARPS Ribbon)
32
I’m in Trouble, Fiona Senior
		FRPS
		
(Rikki O’Neill FRPS Ribbon)
33
The Sirens, Janet Haines
		ARPS
		
(Rikki O’Neill FRPS Ribbon)
34
Other Accepted Images
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CLOSING DATE 17 AUGUST 2014
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